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 ถงักวนสําหรับการผลิตสารเคลือบผิวผลไมเ้ชลแล็ก-คาร์นูบาแว็กซ์ในขั้นตอนการผสม

สารละลายคาร์นูบาซ่ึงเป็นขั้นตอนสําคัญท่ีสุดของการผลิต ได้ถูกนํามาศึกษาด้วยการจาํลอง

พลศาสตร์ของไหลเชิงคาํนวณ ระบบในห้องปฏิบติัการประกอบด้วยถงักวนสําหรับการเตรียม

สารละลายคาร์นูบา ขนาดเส้นผา่นศูนยก์ลาง 220 มิลลิเมตร ติดตั้งใบพดัชนิด 6 ใบ ขนาดเส้นผา่น

ศูนยก์ลาง 29 มิลลิเมตร ห่างจากผนงัถงักวน 44 มิลลิเมตร และ ห่างจากกน้ถงั11.4 มิลลิเมตร ใน

งานวิจยัน้ีเพื่อวตัถุประสงค์สองประการ ประการแรกเพื่อตอ้งการสร้างแบบจาํลองท่ีนาํไปใช้ใน

การศึกษาพลศาสตร์ของไหลภายในถงักวนสําหรับสารละลายคาร์นูบา ผลการทดลองเพื่อหาค่า

กาํลงัไฟฟ้าถูกนาํมาใช้เพื่อสอบเทียบผลการจาํลอง โดยการเปรียบเทียบจากกราฟความสัมพนัธ์

ระหวา่ง Power number (Np) และ ความเร็วรอบการป่ันกวน สําหรับการศึกษาดว้ยวิธีการจาํลอง 

การป่ันกวนแบบราบเรียบในรูปแบบสามมิติร่วมกบัเทคนิค Moving Reference Frame ถูกนาํมาใช ้

โดยแบบจาํลองท่ีนํามาศึกษานั้นมีสองชนิด คือแบบจาํลองหน่ึงเฟส และแบบจาํลองหลายเฟส 

พบวา่แบบจาํลองชนิดหน่ึงเฟสมีความเหมาะสมเน่ืองจากผลการคาํนวณคาดคะเนผลการทดลองได้

อยา่งแม่นยาํและใชเ้วลาในการคาํนวณนอ้ยกวา่แบบจาํลองชนิดสองเฟส และวตัถุประสงคป์ระการ
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กวน ไดแ้ก่ความเร็วรอบใบพดั ความหนืดเชิงจลน์ของของไหล และความเคน้เฉือนพบวา่ การเพิ่ม

ความเร็วรอบ, การลดความหนืดเชิงจลน์ และการเพิ่มความเคน้เฉือนมีผลทาํให้ประสิทธิภาพการ

ป่ันกวนดีข้ึน และขนาดอนุภาคของสารละลายลดลง และวตัถุประสงคป์ระการท่ีสาม แบบจาํลองท่ี
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 A mixing tank in the critical stage of production process of shellac-carnauba wax fruit 

coating solution has been simulated using Computational Fluid Dynamics (CFD) technique. The 
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diameter (T). A 6-blade impeller with 29 mm diameter (D) was equipped at 44 mm clearance 

from the tank wall (off-center) and 11.4 mm from the bottom. The first objective of the research 

was to develop a suitable CFD model to analyze fluid dynamic of carnauba solution inside the 

mixing tank. Power measurement was performed and the power curve (power number versus 
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บทที ่1 CHAPTER I 

INTRODUCTION 

1.1 Motivation 

 Thailand is an agricultural country where is one of the most abundant natural resources 

of tropical fruits. The country’s fresh fruit production is sufficient for domestic consumption and 

also contributes to export revenue. Rambutan is one of the most important export fruits of 

Thailand which accounts for 2% of the total fresh fruit export value [1]. According to the data 

from the Office of Agricultural Economics, the fresh rambutan export in 2012 was 165 million 

baht. In 2011, the export quantity was approximately 7,800 ton which increased to 12,000 ton in 

2012. The growing tendency of export value has continuously increased as shown in Figure 1.1.  

  

 
Figure 1.1 The export value of fresh rambutan between 2007-2012. 
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 However the fresh rambutan export has been limited because the period time during 

transportation affects their qualities. Due to their physiologies are so plenty of spinterns all over 

the peel that they loss water easier after harvest. These conditions cause the problems of wither, 

pericarp browning and quality loss. Thus, the fresh rumbutan shelf-life is short. It is able to stay 

marketable for only 3 to 4 days at room temperature (25oC - 30oC). This is one reason why the 

trade market is still available in particular neighboring countries. Accordingly, the Ministry of 

Agricultural and Cooperatives established the standard principle for rambutans to ensure the 

acceptance qualities for the national and international level [2] such as the rambutans must be: 

fresh in appearance, normal smell and taste. Then postharvest handling for example: packing in 

storage bags or coating with wax emulsion [3] is essential.  

 Coating solution is one of the postharvest techniques, which is applied to fresh fruit 

surfaces to prevent losses (i.e. shrinking, browning, spoilage) and also to extend the shelf-life. 

The main compositions of the coating solution are wax, solvents and surfactant or emulsifier. 

Coated fruits have slower respiration rate and less weight loss than uncoated fruits [4]. Wax also 

helps maintain fresh appearance [5-7]. There are various types and formulas of coating solutions. 

The advantage of each wax is mixed to be suitable for each type e.g. physical property of those 

fruits. There have been the various studies for formula of rambutan coating solution. Sakulwong 

et al. [4] investigated shellac and carnauba wax-based formula for rambutans combined with 

composite plastic bags for additional handling. The results revealed the effectiveness of the 

formula to reduce darkening, browning and weight loss for at least 2 weeks at about 12oC. 

Furthermore, the treated rambutans still had normal flavors.  

 The formula was successfully produced in lab scale. Nonetheless, the extending of 

production in 30-liter tank encountered the difficulties of performing and taking time to complete 

homogenous solution. The increasing particle size was generated due to insufficient impeller 

speed during mixing and/or rate of decreasing temperature of two solutions may cause small 

particle formation. The small particle collected after mixing was as shown in Figure 1.2 

http://etdict.com/index.php?text=physiological
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Figure 1.2 The particle size of shellac-carnauba wax solution increased after mixing. 

 

 The mixing process, studying of flow fields in the mixing tank, and rotating speed and 

pattern of the impeller are crucial for equipment design, system scale-up, troubleshooting process 

and product quality control. Such studies in pilot-scale experiments are require obvious costs and 

time. Moreover, industrial scale must operate several functions simultaneously [2] (dispersion, 

reaction and heat transfer) which do not scale up in the same time. To switch between different 

sizes of scale, the principles of mixing scale-up and scale-down, i.e. geometric similarity and 

dimensionless group are applied. Important characteristics such as Reynolds number, Power 

number and impeller tip speed should be consistent [2, 8]. However, it’s impossible to keep all 

parameters constant. The most important parameter must be selected [9]. Even though laboratory 

experiments are built to investigate the suitable correlations or process parameters for scale-up to 

pilot scale process, they are not always sufficient to ensure the operating conditions [10]. Scaling 

up the mixing of fruit coating solution from the lab scale to the pilot scale has not been successful 

according to the investigation by Sakulwong et al. To achieve scaling up subject, adequate 

experiments are required to determine the scale-up procedure. In case of complex and costly 

experiment, an alternative method is to solve the balance equations numerically so that its results 

clarify the fluid dynamics behavior and mixing processes. 
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There has been an increasing interest in Computational Fluid Dynamics (CFD) for the 

study of fluid flow in stirred tanks. Such studies have been reported in the published literature 

since the 1980s [11]. CFD technology has been widely used for the simulation of mixing in 

stirred tanks [2, 10-13]. The CFD is a useful tool to study flow behaviors such as flow pattern, 

power consumption, mixing mechanism etc. [14, 15] which are macro mixing performance. The 

macro mixing performance is one of the most interesting subject for scale-up because it affects 

general mixing characteristics such as mass transfer in the tank [2]. Moreover, CFD is employed 

to analyze the scale up processes, in order to decrease the risk of any uncertainties in the new 

process [16] and minimize the expense and time consuming from experiments [17]. CFD 

modeling has been successfully used to study for scaling up of a laboratory experiment to a pilot 

process [2, 18]. However many CFD simulation studies have focused on stirred tanks of which 

standard impellers are located at the center. A stirred tank with a unique and off-centered impeller 

has been applied in the mixing process of shellac-carnauba wax coating solution because 

circulatory flow and swirling can be prevented. In addition, it also eliminates the need for baffles 

so that product hang-up on the baffle and thus, cleaning can be avoided. Such configuration will 

present a challenge to demonstrate its behavior. CFD method is useful to predict flow pattern in 

such complex configurations including hydrodynamic detailed of throughout the entire tank. 

Furthermore, carnauba wax derived from vegetable wax will be firstly introduced in CFD 

modeling. 

 In this research, the critical stage [19] in the production process of shellac-carnauba wax 

fruit coating solution, i.e. the mixing process of carnauba solution, has been studied using CFD 

simulation combined with the experimental data. The carnauba solution consisted of melted 

carnauba wax mixed with pre-wax solution, i.e. de-ionized water, 25% ammonia solution and 

oleic acid, at 85oC will be an important part of the research. As a result, the solution prepared this 

step in large-scale tank will not be mixed homogeneously with shellac solution because of 

insufficient impeller speed during mixing and/or rate of decreasing temperature of two solutions. .  

 This thesis partially brought the cause from impeller speed which influence on mixing 

performance to examine. Also, some scale-up criteria are summarized. However, the optimum 

condition in lab scale has not been elucidated in this research.  
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 A laboratory-scale process in a 5-liter tank with a 6-blade impeller will be performed for 

an initial validation of the CFD model. The results on power required to rotate the impeller at 

various speeds will be measured for the validation.  

1.2 Objective of the research 

 1.2.1  To develop a suitable CFD model for analyze fluid dynamic of carnauba  

  solution inside the mixing tank. 

 1.2.2  To study the phenomena of fluid mixing using the validated CFD model. 

 1.2.3  To summarize and guide the scale-up criteria for carnauba solution tank. 

1.3 Scope of the research 

1.3.1 Develop a suitable CFD model of carnauba solution mixing in the lab-scale 

mixing tank.  

1.3.2 Validate the model by comparing the power number estimated as a function of 

impeller speed from the simulations with measured values from the experiments. 

1.3.3 Apply the validated model to carnauba solution mixing in a large-scale mixing 

tank.  

1.3.4 Suggest a scale-up criterion for maintaining similar flow pattern between small-

and large-scale mixing tank. 

1.4 Benefits of the research 

 1.4.1 To obtain suitable model for mixing behavior inside a mixing tank with off- 

  center impeller. 

 1.4.2 To elucidate the transport phenomena in a mixing tank using the CFD model. 

 1.4.3 To suggest a guideline scale-up criteria which are suitable for carnauba  

  solution tank. 
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บทที ่2 CHAPTER II 

THOERY AND LITERATURE REVIEWS  

2.1 Fruit coating production process development of shellac- carnauba wax based 

 Since Sakulwong et al. [4] successfully investigated shellac and carnauba wax-based 

formula for rambutans by dipping method, this treatment helped maintain rambutan quality for at 

least 2 weeks at about 12oC when combined with composite plastic bags. Figure 2.1 showed 

shellac and carnauba wax based for dipping rambutan. Then, expanding the production capacity 

in a laboratory to an industrial scale was attempted. They confronted the difficulties of 

performing, taking long time and increased particle as discussed in previous section.   

 

 
Figure 2.1 Shellac and carnauba wax based for dipping rambutan. 

  

 Thereafter, Nirotanan et al. [19] developed the production process of shellac and 

carnauba wax based of Sakulwong et al. method [20] to be simpler and more effective. The wax 

coating solution was prepared by melting the carnauba wax at 85oC before adding with pre-wax 

solution (which consisted of de-ionized water, 25% ammonia solution and oleic acid) at the same 

temperature so that it was easier to be mixed. Then, the carnauba solution was gradually added in 

shellac solution at 60oC. They investigated that the impeller speed of 180 rpm was sufficient to 

generated homogenous solution. The particle size of the final solution was in the range between 

CHAPTER II 
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7.96 µm to 16.76 µm. At lower of that speed, they found that the solution would be not 

homogenous after mixed carnauba solution in shellac solution. Thus the impeller speed was major 

criteria of mixing efficiency. However scale up ambition have been still required to be achieved. 

2.2 Fluid Mixing 

2.2.1 Studies on mixing 

The study of non-reacting, turbulent fluid mixing can be divided into three aspects, the gross 

scale, fine scale and turbulence energy spectra. 

 Gross scale study is relating to the overall flow pattern in the tank. This study can give 

qualitative and quantitative information which is useful of primary selection of impeller type and 

design parameter in system. 

 Fine scale study base on three different theories; direct numerical simulations (DNS), 

large eddy simulation (LES), and the Reynolds averaged Navier-Stokes (RANS) approach. This 

method still requires the computational technique. 

 Turbulence Energy spectra studies the various velocity fluctuation in order to 

determine the turbulent energy spectrum, E(k) including turbulence length scale. 

  

2.2.2 Impeller type  

 In mixing application, impeller is an essential tool as it produces flow and shear to fluid 

[21]. That is to say, when impeller is rotating, it transports the kinetic energy from the blades to 

the surrounding fluid. Generally, the purposes of impeller i.e. producing flow or shear depend on 

mixing application. In application of blending the liquid and solid suspension is more required 

impeller generated mass flow while reacting application is more required impeller which 

generates shear. 

 Impeller type also can be classified into two types as it circulates fluid axially or radially 

so that impeller is conveniently divided according to which these flow direction is important.  
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             a)       b) 

  

a) Flow pattern for axial impeller,    b) Flow pattern for radial impeller  

 

2.2.3 Mixing application 

 

 Laminar and turbulent mixing plays an important role in chemical engineering 

application. In mixing process, species transports on different length scales. Convection is 

considered on large scales, while diffusion is analyzed on molecular scales.   

 Some example applications of laminar mixing are high-viscosity materials in food 

industries [22-24] and manufacture of lubricant [25], the production of cosmetics such as creams 

and unguents, the mixing of detergents and the agitation of shear-sensitive cell in 

biopharmaceutical industries [26, 27]. 

Mario et. al [28] studied the performance of eccentric impeller in laminar stirred tanks 

using tracer visualization technique and laser induced fluorescence (LIF). The working fluids of 

the experiment were mixture of glycerin and water (Re = 12.5-50.0). From the result they 

proposed the mixing performance to eliminate unstable manifolds which can be avoid damage 

Figure 2.2 Flow pattern of different impeller type . 
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generated by mechanical stress such as mammalian cell culture and biotechnological application. 

However, in conclusion they suggested that three-dimensional comprehensive of mixing 

mechanisms should be further studied which computational technique is required.  

2.3  Scale-up and scale-down of liquid mixing system 

 When system geometry is changed, the physical and mechanical variables such as 

chemical environment in the tank will not be constant. Therefore, the productive quality has been 

changed. There is no universal method which is employed in scale translation. Many methods 

have been proposed depending on the mixing purposes. There have been different factors affected 

the particularly processes. The basis of scale-up or scale-down principles is the similarity and 

dimensionless groups [8]. The criteria for similarities are expressed in term of the geometrical 

similarities among different sizes of equipments such as shape and of the force ratio of 

corresponding dimensions are maintained. Global scaling dimensionless analysis such as 

Reynolds number, power number and Froude number were proposed in published literature by 

Nagata et al. [8]. 

 CFD method has been widely used to analyze the system in experimental scale before 

scaling up for pilot scale. Li et al. [2, 10, 17, ,18, 29, 30] applied CFD for scale-up study by 

comparing macro mixing performance such as power number, flow number, secondary flow 

number and pumping efficiency in various laboratory scale tanks. The results of those parameters 

had been slightly changed so the operating condition of pilot-scale can be chosen. However, 

micro mixing performance study was their next step work. In this same method, Compolo et al. 

[10] used CFD to investigate the power and impeller speed for various operating conditions, they 

successfully found the operating conditions which ensured the optimum fluid dynamic efficiency. 

Moreover, Alexopoulos et al. [17] developed CFD to compared the micro mixing performance 

such as energy dissipation rate in a scale-up reactor, the result showed agreement of the small-

scale and large-scale. Obviously, such method has no scaling up or scaling down problems 

because it solves the fluid dynamic equations in the same phenomena as mention by Jayanti et al. 

[31]. However, the physical phenomena are still required. 
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2.3.1 Reynolds number  

 Reynolds number (Re) is a ratio of inertia and viscous forces. The Reynolds number (Re) 

is the dimensionless number which describes the hydrodynamic in the system. It provides a 

criterion for dynamic similarity [9]. The Reynolds number (Re) is defined as 

 

    

µ
ρ 2

Re ND
=

  (1) 

 

Where     ρ   = density of fluid (kg/m3),  

    N  =  Impeller speed (Revolutions per second, rps), 

    D =  Outer diameter of impeller (m),  

    µ  = Viscosity of fluid (kg/m-s). 

 

2.3.2 Froude number 

 The Froude number (Fr) represents the number which accounts for vortex formation 

occurs and effects in the system. It describes the ratio of inertial to gravitational forces. 

 The Froude number (Fr) is defined as 

 

  
g

DNFr
2

=                              (2) 

 

Where      N  =  Impeller speed (Revolutions per second, rps), 

    D =  Outer diameter of impeller (m),  

    g = Gravity force (m/s2) 

2.3.3 Impeller tip speed   

 The impeller tip speed (Vtip) is defined as 

 

 



11 

 NDV
tip

π=   [m/s]  (3) 

 

 Where    N  =  Impeller speed (Revolutions per second, rps), 

    D =  Outer diameter of impeller (m). 

 

 Impeller tip speed (Vtip) is related to the geometry and the agitation rate of mixing tank 

[32]. 

 

2.4 CFD model of mixing process 

 CFD modeling was one approach of studies involving  in mixing mechanism : molecular, 

eddy and bulk (convection) [33] which was proposed to be realistic method. The models 

necessary for the laminar mixing included impeller models or/and multiphase model. This section 

summarized the CFD model relating to our thesis. Details were discussed as follows: 

2.4.1 Impeller modeling 

 Impeller played a fundamental role in mixing process, since it was a crucial tool to 

determine production quality. The approaches commonly used for modeling of rotating impeller, 

were multiple reference frame (MRF) and sliding mesh (SM). Both of them divided solution 

domain into two regions; inner region which rotated with the impeller and outer region which was 

stationary. The flow with rotating reference frame models was defined as Figure 2.3 [34]. The 

interface between two reference frames (dashes line) was assumed to be stationary flow. The 

MRF model was applicable for a steady flow and for a system with weak impeller-baffle 

interaction. Conversely SM model was used for an unsteady which unsteady interaction was not 

able to be neglected i.e. when the impeller-baffle interaction is strong. In case of time-dependent 

system, SM model calculated the phenomena of the impeller rotation more accurately, but had 

high computational expense [11, 35]. 
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Figure 2.3 Domains of a rotating reference frame of single impeller. 

  

 CFD simulation of flow fields in stirred tanks have been studied by many authors [17, 

36-38]. In baffled mixing tanks, simulations were mostly carried out using the SM [39] which 

were suitable for mixing with the interaction between impeller and baffle. In case of unbaffled 

vessels, the simulations have been suitably performed using MRF where the impeller was 

assumed to be stationary and the reference frame or coordinated system was rotated. As a result 

of it was easy to define the outer-wall boundary condition [17, 40]. 

 Deglon et al. [41] demonstrated CFD simulation for six-blade Rushton turbine impeller 

in baffled tank which the system was consisted of 25oC water by using MRF model and the 

standard k-ε model ( i.e. the turbulence model ). Higher-order discretization scheme with very 

fine grids was applied. They minimized the computational demand by using the pseudo-steady 

state MRF impeller rotational model. It was shown that the simulated results by the MRF model 

were similar to those by the SM impeller rotation model for steady-state stirred tanks. 

  Consequently, in this research, both of MRF and SM can be applied. Nevertheless, SM 

model consumes more computational time. 
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2.4.2 Multiphase model 

 Accordingly multiphase flow was widely present in variety of chemical engineering 

application. Its particular flow regime comprehensive was important. The use of multiphase flow 

modeling of CFD simulation was extensively applied. However there was no universal 

multiphase model could be applied for all regimes. The selection of appropriate multiphase flow 

model CFD for such flow was prior because it determined the ability to accurately prediction of 

the realistic behavior of the fluid flow. At present CFD simulation provides several type of 

multiphase flow model according to their level of complexity. These example type were 

summarized as follows in Table 2.1 [42]. 

 

 

Model Description Flow regime 

Eulerian Model - Continuity, momentum and (optionally) energy       

   equations are solved for each phase. 

- Slurry flow 

- Fluidized bed 

- Droplet flow 

Mixture Model - Simplified from Eulerian approach 

- Solved the continuity, momentum and energy equations    

  for the mixture.  

- Allow the phases to be interpenetrating. 

- droplet 

- bubble  

- slurry flow 

Volume Of Fluid 

(VOF) Model 

- Tracked location and motion of the interface      

  between phases  

- Two or more fluids (or phase) are not interpenetrating. 

- Solved the continuity, momentum and energy equations      

by sharing velocity among the phases. 

- slug flow  

- free surface flow 

 

Table 2.1 The various types of multiphase flow model  
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2.4.3 Model validation  

 To evaluate the CFD model, the simulation results were compared with the experimental 

data. An extensive number of literatures [10, 11, 43, 44] used power number to validate the 

simulation, due to power number is proven to be a reliable predictor. Marina et al. [10] informed 

that they chose this parameter because of three reasons: it’s indicative  parameter of complex 

three dimensional turbulent flow; it’s normally available by industries: and it can be easily 

measured.  

 The dimensionless power number (Np) was defined as 

 

   
⋅=

,

53DN
PN

p ρ                       (4) 

 

Where    P  =  Power the impeller (Watt),  

   ρ   =  Density of fluid (kg/m3),  

   N  =  Impeller speed (Revolutions per second, rps), 

   D =  Outer diameter of impeller (m).  

 

 The power can be measured through the total torque (Γ ), m-blade impeller was 

 calculated by  

 

   Γ= mNP π2 .     (5) 

 

 The total torque required to rotate the impeller which can be calculated from summation 

of pressure differential between the front and the back on each blade at surface element i, Ai is 

area of the surface element i and ri is radial distance from axis of shaft on the position which 

impeller is equipped [31] . 

   ( )
iiii

rAP∑ ∆=Γ       (6) 

  

The Reynolds number (Re) was defined in Equation (1) 
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 The data of power number and Reynolds number obtained from varying impeller speed 

was then plotted as general energy curve or power curve on log-log plot. It illustrated the 

relationship between power number and Reynolds number of unique system.  

 

 
Figure 2.3 A typical power curve [45]. 

  

 Figure 2.2 showed the general power curve, it depicted that it consisted of three regions 

of the mixing.  

 At low Reynolds number, the flow was in laminar regime in which the mixing initially 

and slowly occurred. The blending was carried out by the velocity distribution without turbulent 

dispersion. Consequently, the effects of molecular diffusion were very slow. In this region, power 

number was decreased corresponding to Reynolds number [45]. 

 At higher Reynolds number, the flow was turbulent. The velocity distribution eventually 

generated interfacial area between components. In this region, the fluid was rapidly mixing as a 

result of turbulent eddies were present. Thus, molecular diffusion effects in fluid were faster. In 

turbulent region, power number was constant. 

 In the region between laminar and turbulent flow was transition region. However, this 

region had no simple mathematic relationship between power number and Reynolds number.  
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 Among power number - Reynolds number plot, each type of impeller including its 

environment has its own particular shape of curve as shown in Figure 2.4. 

 

 
 

 

Figure 2.4 Power curves of different impellers [45]. 

 

2.5 Computational fluid dynamics (CFD) model of shellac-carnauba wax fruit coating 

solution. 

 Nirotanan et al. [46] used CFD modeling to scale up the mixing tank of shellac-carnauba 

wax fruit coating solution. In their study, the critical stage of production in a 5-liter mixing tank 

was simulated. Then the model was applied to calculated impeller speed to be used in 200-liter 

tank. Nonetheless, they still had no rigorous validation data from experiments to evaluate their 

model. 
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2.6 Computational fluid dynamics  

 Computational fluid dynamics (CFD) is a field of study relating fluid mechanic by means 

of numerical solution of conservation equations for mass, momentum and energy in flow regions 

of interest, couple with additional equations relating to the problems [33]. CFD is a complement 

approach between theory and experimental approaches. It is a powerful approach as the research 

and design tools. There are three main steps for CFD simulation it provides three main steps (i) a 

pre-processor (ii) a solver (iii) a post-processor  

Pre-processor 

 In this step, the information such as computational domain, grid (mesh) generation, 

physical and chemical phenomena (i.e., governing equation), material properties, etc. is set up in 

CFD simulation software, Fluent ( Fluent 14, ANSYS Inc., Lebanon, NH., USA). 

Solver 

 The second step, after the meshes have been read into the solver, the partial differential 

equations (based on Navier-Stokes) are discretised over the meshes [33]. Boundary and initial 

conditions are defined to CFD. Then, a large set of nonlinear simultaneous equations is produced. 

To solve these, there are three distinct streams of numerical solution discretisation, including 

finite difference, finite element and finite volume methods. Generally, the solver performs the 

following steps: 

• Approximate unknown flow variables by simple function 

• Carry out in discretisation step, they transforms the PDEs into algebraic 

equations 

 Fluent is computer program for modeling fluid flows, heat transfer and chemical 

reactions in complex geometries. Fluent is the most widely used commercial CFD code both in 

industry and in academia. It is based on finite volume method. Meshes generated by other 

meshing software can be imported into Fluent.  Fluent provides researchers with powerful tools to 

investigate various engineering flow problems such as incompressible or compressible flows, 

Newtonian or non-Newtonian flows, viscous or inviscid flows, laminar or turbulent flows, single-

phase or multi-phase flows, species transport etc. in both steady-state and transient situations. 

Various modeling features are available to apply FLUENT to specific applications.  
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 For an incompressible system, an independent equation to calculate pressure is absence. 

A pressure-velocity coupling algorithm was required to derive equations for pressure from the 

continuity and momentum equations. In this study, the Coupled scheme for Pressure-Linked 

Equations algorithm was applied. Then, Pseudo Transient was enabled as recommended by 

FLUENT as it helped decrease number of iterations for convergence. The PRESTO Method for 

Pressure-Linked Equations algorithm was applied. 

 Post-processor 

The final step, post-processor provides full-field data such as visualization result, 

geometry and grid display, vector plot, line and shaded contour plots, etc. at each and every point 

in the domain.  

2.7 Governing equations of fluid dynamic 

 CFD is based on fundamental physic principles of fluid dynamics 

General transport equation 

 

( ) ( ) ( )
φ

φρφρφ S
t

+⋅∇Γ⋅∇=⋅∇+
∂

∂ u
   (6) 

 

 The general balance equation over the stirred tank can be written for each system 

variable ø in Equation 1 

  

1. Mass is conserved (Continuity Equation) 

 

( ) 0u =⋅∇+
∂
∂ ρρ

t
    (7) 

   

 The fluid density is designated by 𝜌. The velocity vector (u ) of fluid is defined as   

   kjiu wvu ++=   

For an incompressible fluid, the density of fluid (𝜌) is constant, consequently continuity 

equation can be arranged as 
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                                     0=⋅∇ u                                                    (8)  

 2. Newton’s second law of motion (momentum equation) 

 
M

Sp
Dt
Du

+⋅∇+−∇= τρ
                         (9) 

 The pressure and viscous stress of fluid are denoted by ρ and τ  respectively.  

SM is the momentum source term. 

 In this study, the flow model is based on solving Navier-Stokes equations for laminar 

mixing. For solving a set of nonlinear governing equations in three dimensional, CFD code 

(Fluent, ANSYS Inc., Lebanon, NH), a finite volume based fluid dynamic analysis program is 

utilized.  
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Analyze the influences on flow 

behavior. The influence of rotational 

velocity, fluid viscosity and shear 

stress on flow behavior (Section 3.6) 

 

 

  

 

บทที ่3 CHAPTER III 

RESEARCH METHODOLOGY 

3.1 Objective and Approach 

 According to the objectives of this thesis discussed previously in the introduction, the 

overview approaches to achieve these objectives were delineated in the flow diagram Figure 3.1.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.1 The flow diagram of thesis objectives and its approaches. 

CHAPTER III 

Develop a suitable model to study the 

fluid dynamic inside the carnauba 

solution tank (Objective 1) 

Experiment and numerical simulation 

were setup. The simulation result of 

power curve was compared with the 

experimental result. (Section 3.2-3.5) 

Study the phenomena of fluid inside 

the carnauba solution tank  

(Objective 2) 

Objective Approach   

Summarize criteria for scale up. 

(Objective 3) 

Compare the scaling up criteria which the 

kinematic is similar between in the lab-

scale and large-scale tank. (Section 3.7)  
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 A suitable CFD model of carnauba solution in a lab-scale tank which equipped with  

6-blade and off-center impeller has been developed. The validated CFD model used to study the 

phenomena inside the mixing tank and influence of rotational velocity and fluid viscosity on flow 

behavior. Besides the CFD model in lab-scale will be applied in pilot-scale tank in order to guide 

the dimensionless criteria of scaling up. 

 To delve into the detail of each approach in the next sections, the procedure overview can 

be divided into two parts, preliminary study and carnauba solution study. Similarly, the two parts 

of study were conducted in 220 mm diameter (T) lab-scale mixing tank. 6-blade impeller with 29 

mm diameter (D) was equipped off-center at 55 mm clearance from center and 11.44 mm 

clearance from bottom. The dimensions of the mixing tank, the impeller and located position were 

presented in Table 3.1 and Figure 3.2.  

 

 

Dimension of tank and impeller (mm) Value 

Tank diameter (T) 220 

Liquid height (H) 106.48 

Liquid volume (V) 5 L 

Impeller diameter (D) 29 

Impeller clearance from tank base (Cimp) 
11.44 

Impeller clearance from tank center (Cc) 
55 

Number of blade 6 

Blade width (b) 18.93 

Blade angle 60 

Table 3.1 Dimension of the mixing tank and impeller 
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Figure 3.2 Physical geometry of the mixing system and 6-blade impeller. 

 

3.2  Preliminary Study 

 The purposes of a preliminary study were made in order to initialize the solution of 

model. The setting up boundary condition and post-processing were examined. Due to the 

carnauba and itself solution preparation was costly material and required time to conduct an 

experiment. Water was initially used instead because it was simple, less cost and fundamental 

fluid of most industrial application. Also, other purpose of the study was to investigate the effect 

involving in viscosity of fluid inside mixing tank (Objective 2 of the research). The influence of 

viscosity of water and carnauba on flow behavior will be compared. Procedures of this study 

consisted into two parts, experiment and CFD simulation. 

3.2.1 Experimental Setup 

 The experiment was set up to obtain power of the impeller by means of electrical 

measurement using multi meter. Water is filled at the level of 150 mm. The data of current 

(amperes) were collected while water was mixing at various impeller speeds from 2000 to 2900 

rpm. The constant potential difference (volts) was also measured.   

 

 

STIRRER 
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Mixing tank equipped with 6-blade impeller 

 

 

Figure 3.3 Power measurement setup of water.  

 

 The data of voltage (volts) and current (amperes) was converted into power (watt) as the 

equation of Ohm’s law formula, [47] 

    P = IV    (10) 

Where 

    P  =  Electrical power (watts), 

    I  =  Current (amperes), 

    V =  potential difference (volts). 

 

 The experiment was primal procedure with the purpose of classify the flow region i.e. 

laminar, transition or turbulent which could be identified by power curve as discussed in the 

literature reviews in Figure 2.3. Since, the existed region from experiment was crucial to choose 

the appropriate model solution in step of simulation setup which was discussed in the next 

paragraph. 

 

Stirrer 

Multi meter 
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3.2.2 Simulation Setup 

 Computational simulation was carried out based on experimental setup. The transport 

equations were numerically solved using the commercial CFD simulation software (Fluent, 

ANSYS Inc., Lebanon, NH). The Microsoft Window 7 Home premium computer installed on 

Intel Core i7-2600 processor (3.84 GHz, 64 bit) and 8.00 GB RAM was utilized. The steps 

towards solving the problem were determining the geometry, meshing and initializing the solution 

of the model. These procedures and required information were described as follow subsections.  

 

 3.2.2.1 Geometry consideration 

 The geometry of the model was generated according to Table 3.1 and Figure 3.2.  

Figure 3.4 and 3.5 showed the comparison of actual impeller shape and computational impeller.  

 

.  

 

 

 

   

 

 Figure 3.4 Actual impeller    

 

 

 

 

 

Figure 3.5 Computational impeller 
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 The computational geometry was generated in three-dimensional tank (Figure 3.6) 

because the impeller was placed off-center so the geometry was not able to be partial in symmetry 

domain. The partition technique was applied in order to be easier to generate mesh. 

 

 3.2.2.2 Mesh generation 

 Once the geometry was made, the computational domains were then defined. This thesis 

was employed the MRF technique as discussed previously in the literature reviews. Region inside 

the mixing tank was divided into two reference frames; the moving reference frame attached to 

the region near impeller motion and stationary reference frame attached to the rest region. The 

Figure 3.6 depicted the two reference frames inside the mixing tank by the use of the partition 

technique so that a structured mesh of hexahedral mesh could be create in complex geometry. The 

uniform structured grids were created due to its advantage of taking less time than an unstructured 

grid calculation. The structured meshes were applied throughout the mixing tank as shown in 

Figure 3.7. 

 

 
 

 

Figure 3.6 The three dimensional reference frames of the mixing tank. 
Moving reference frame Stationary reference frame 
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 Figure 3.7 Structured mesh throughout the mixing tank 

  

 

 

 Finer mesh was applied in especially better resolution in region of impeller motion in 

order to capture the higher velocity gradient zone. The quality of mesh was repeatedly improved 

by using adaptive mesh technique in grid sensitivity analysis in which will be described in section 

3.6. 

 

 3.2.2.3 Model solution 

 After the meshed geometry was introduced into the solver, the final step was initializing 

solution of the model. Some assumptions were made in order to simplify the flow problem and 

minimize the time required for calculation.  

 

 Model assumptions are the followings: 

 As discussed previously that the preliminary studies was to investigate the mixing of 

water inside the tank. The model solution was performed in two models: single phase (water) and 

Coarse mesh 

Fine mesh 
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multiphase model (water-air) which was based on different assumptions. Therefore the working 

fluids were almost water, considered to be incompressible. 

 Due to the mixing tank was insulated, there was no external source of heat transfer into 

the system. Thus inside the mixing tank was isothermal system. 

 This research applied MRF model with the assumption of the moving and stationary zone 

interactions were relatively weak so the flow was a steady-state approximation. 

 However additional different assumptions for each case of study are further discussed in 

an upcoming subsections. 

 The next subsection described the solution initialization details of single phase and 

multiphase model. The two models were based on different assumption. Complete specification 

setups of both models were in Appendix A and B. 

  

3.2.2.1 Single phase model  

The viscous model for laminar flow called single phase model was simulated in case the 

effect of air on the top of the mixing tank was neglected so that the system was fulfilled with 

water.  

Parallel processing was used instead of series because of minimizing the solving time in 

FLUENT as reported by Hannah Duscha et.al. [48]. Pressure-density Based solver was used that 

it solves the equations of continuity to calculate velocities based on pressure. The solution 

methods were kept at default of laminar model for single phase flow.  

Material for single phase simulation was pure water. The physical properties of simulated 

materials are shown in Table 3.2.  

General specifications relating to the rotating reference frame were on Cell Zone 

Conditions for moving zone and stationary zone. Moving zone was set up the rotational velocity 

from 2000 to 2900 rpm respectively. While stationary zone was keep at default, the shaft was set 

as moving wall at the same rotational velocity. The other zones were kept as default because they 

were stationary wall.  
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On Reference Values, Area and Length were accounted from impeller configuration, 

Velocity was converted from the rotational velocity, the others i.e. Density, Pressure and 

Temperature were water properties. 

Selecting Monitors, the pressure and velocity in a new created surface were additional 

monitored during solving combined with residual error monitored. Due to the default 

convergence criteria are not sufficient to access the correct flow feature in a mixing tank [35]. 

This technique helped observe the solving solution besides decreasing Residual constraints as 

proposed by Hannah Duscha et.al. [48]. This research applied this technique excepting for 

Residual monitored. The Residual of all criteria was initially enabled until 1x10-3error criteria, 

then the residual monitor of all criteria was disable check. The calculation of the solution was 

continued in which Surface monitors of pressure and velocity maintained in place. The velocity 

and pressure Surfaces showed the results of solution throughout the solving process. These 

Surface plots helped ensure the final solution accomplished. Consequently, the trends of Area 

Average Weight of velocity and pressure plot were observed until they were constant. 

 

3.2.2.2 Multiphase model 

 The viscous model for laminar flow solving for each water and air phase called 

multiphase problem was developed in case of taking into account of air in the system. This case 

was used because of the assumption that air affected the mixing.  

 General problem setup for multiphase was similar to the single phase with a few different 

options. The first difference was the Multiphase on Models setup. The Multiphase was turn on 

that consisted of three Multiphase models i.e. Volume of Fluid (VOF), Mixture and Eulerian. 

VOF model was chosen to dictate the interactions between the two phase of air and water because 

of literature and numeric recommendations  [42] in which it was utilized for this type of two-

phase flow and as mentioned in Chapter 2 literature reviews. 

  The Materials were indicated as water and air in which water was primary phase and air 

was secondary phase. As a result of water was considered to be continuous phase while air was 

dispersed phase. 
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 The second difference, selecting Solution Method of the (Multiphase) Couple was the 

scheme which recommended in the Help panel of ANSYS FLUENT [35]. This method solved all 

equations for each phase velocity and shared pressure correction simultaneously [49]. Coupled of 

Pressure-Velocity coupling was proposed as it was capable in steady state and transient with large 

time step condition. 

 On boundary condition and new surfaces on Monitored were created as same as single 

phase setup. 

 The third difference, after Initializing on Solution Initialization, the primary and 

secondary phase zones were required. A Hex shape of on Region Adaption was created in z- 

Coordinate. The z-coordinated was defined the height of primary phase. Patching on Solution 

Initialization, water phase volume fraction was indicated.   

 The Courant number was kept default without changing relaxation factor. 

 

 Since the preliminary study was obtained the solution of model which the result was 

agreement with experiment (the detail will be discussed in the result and discussion), then the 

CFD model was applied to carnauba solution.  

 

3.3 Carnuaba solution Study 

 The carnauba solution was an actual fluid which will be used in scale up proposal. This 

study was applied from preliminary study but some differences were made in order to modify 

model. The procedure of carnauba solution was also consisted of experiment and simulation as 

present followings. 

3.3.1 Experimental setup 

 Shellac–carnauba wax fruit coating solution, the preparation step of carnauba solution 

prior influenced the final solution. In other word, carnauba solution step was the critical stage as 

mentioned in introduction. Carnauba solution consisted of percentage by volume of 81 % water, 5 

% carnauba wax, 9 % ammonia and 5 % oleic acid was prepared. The carnauba wax was initially 

melted at 850C. Then the melted carnauba wax was eventually added in the mixture solution of 
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water, ammonia and oleic acid in while it was mixing at 850C.  A thermometer was equipped in 

order to keep the production process at 850C during mixing.  Then completed emulsion of 

carnauba solution was setup to measured power as the same method of preliminary study at 

impeller speeds from 2000 to 2900 rpm. Figure 3.8 shows the power measurement setup of 

carnauba solution. 

 

 
Figure 3.8 Power measurement setup of carnauba solution. 

3.3.2 Simulation setup 

 The simulation setting up of carnauba solution was similar carried out to preliminary 

study. The carnauba solution was employed both of the single phase and multiphase model for 

comparing the accuracy of prediction. The suitable model was chosen based on validation result 

in which will be discussed in the next chapter.  

3.3.2.1 Single phase model 

 The single phase of carnauba solution was applied from preliminary study of single phase 

model. The procedure was similar to that simulation. Also, the assumptions were based on 
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preliminary study of single phase model. A few differences were made. The first difference was 

creating Materials. Carnauba solution property was indicated instead of water. Required carnauba 

solution property was shown in Table 3.2.  

 

3.3.2.2 Multiphase model 

 Also, multiphase simulation of carnauba solution was developed in which carnauba wax 

and water were numerical materials.  

 The multiphase model step of carnauba solution was similar to the preliminary of 

multiphase simulation. Minor differences were made. The first difference, Materials are indicated 

as carnauba wax and water. 

 VOF and Mixture model for multiphase flow were tested the prediction to dictate the 

interactions between the two phases of water and carnauba wax in the system. The result of 

Mixture model revealed the suitable to prediction the power number with the less time required. 

In this case mixture model was used for further studied. The multiphase flow model required a 

primary and secondary phase. This case water was the primary phase (continuous phase) and 

carnauba wax was secondary phase (dispersed phase). 

 The others criteria were setup the same as multiphase of preliminary study as previously 

reviewed.  

Table 3.2 Physical property of materials. 

Material Viscosity (kg/m-s) Density (kg/m3) 

Water (25oC) 0.001003 998.2 

Air (25oC) 1.789e-05 1.225 

Carnauba solution (850C) 0.00235 875 

Carnauba wax (850C) 81.296 833 

Water (85oC) 0.000334 968 
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3.4 Grid sensitivity analysis  

 The five resolutions of meshes were conduct in order to investigate grid sensitive which 

affect on the prediction of CFD simulation of the transport phenomena inside mixing tank.  

The refiner mesh was made with the purpose of improving the accuracy of the simulation results. 

 The adaptive mesh function on FLUENT was utilized to improve mesh to sufficiently 

capture the changes on velocity gradients region i.e. the area enclose the impeller. FLUENT 

provided tools to create mesh in various particular applications such as Boundary Adaption, 

Gradient Adaption, Region Adaption and Volume Adaption. The recommendation of each 

application described in the Help section of ANSYS FLUENT.  

 This thesis applied Boundary Adaption function, in order to refine the meshes the area 

within the boundary of impeller. Boundary adaption was used to create five resolutions of mesh 

which were: Coarse, Adapt I, Adapt II, Adapt III and Adapt IV. The resolution was increase until 

the solution had no notable difference and the error from experimental result was decreased. The 

number of grid resolution was shown in Table 3.3 

 

Table 3.3 The various resolutions of grids creating for grid sensitivity analysis. 

Grid number Case Number of cell 

I Coarse 86,196 

II Adapt I 140,628 

III Adapt II 368,436 

IV Adapt III 1,289,076 

V Adapt IV 4,990,452 

 

3.5 Validation approach 

 To validate the prediction of CFD model, preliminary and carnauba solution model were 

calculated torque generated by impeller at various speeds. Then torque datum was converted in 

term of Power number (Np) as shown in Equation 1 while Reynolds number (Re) was calculated 
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according to Equation 4 as mention in literature review. The plot relationship between Power 

number (Np) in Y-axis and impeller speed (rpm) in X-axis was generated. Then the plots derived 

from experiment and simulation was compared. 

 

3.6 The effect on flow behavior 

 Since, the flow regime inside the tank represents the mixing behavior within the process. 

The mixing characteristic also influences the product quality. The relevant parameters in which 

affected the flow regime or velocity profile were selected to study in this thesis, the effects were 

discussed in the next section. 

3.6.1 Effect of rotational velocity 

 The qualitative contour and vector plot derived from CFD simulation in which presents 

flow pattern creates by the impeller help elucidate whether the impeller speed is sufficient to mix 

or whether there are dead zone in the tank. Comparison of impeller speeds of 2000, 2700 and 

2900 rpm affected on flow regime will be discussed.  

3.6.2 Effect of fluid viscosity  

 When the material property is changed, the Re number is also changed. Two ranges of 

Reynolds number are investigated using water and carnauba solution. At the same rotational 

speed of 2000 rpm, the velocity profile of water and carnauba solution will be compared. Detailed 

of Re range for two working fluids were given in Table 3.4. 

 

Table 3.4 Viscosity of water and carnauba solution. 

Working fluid Viscosity (kg/m-s) 

Water 0.001003 

Carnauba solution 0.00235 
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3.7 Scale up study 

As mention in introduction, this thesis is also aim to investigate the effect of different scale 

up criteria so that we can guide the suitable criteria.     

3.7.1 Dimension of large-scale tank 

 The large-scale tank figure was similar to lab-scale tank. The configuration of the tank 

was conducted by adjusting the scale of the lab-scale tank from millimeter to centimeter (i.e., 

scale up by 1000 times). Selecting the Scale on FLUENT, changed the unit of all coordination 

into centimeter. The 220 cm diameter (T) large-scale tank consisted of  a 6-blade impeller with 29 

cm diameter (D) was equipped at 44 cm clearance from the tank wall (off-center) and 11.4 cm 

from the bottom. 

 

 This thesis employed the scale up criteria i.e. Reynolds number (Re), Froude number (Fr) 

and impeller tip speed (Vtip) which was individually kept constant. The Reynolds number (Re) 

and Froude number (Fr) are based on conservation of force ratio. Impeller speed tip (Vtip) is based 

on rate of agitation. 

3.7.2 Reynolds number (Re) constant 

The desire is to have the same hydrodynamic large scale as small scale. This can 

be written as an equation:  
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3.7.3 Froude number (Fr) constant 

The desire is to have the same vortex formation in large scale as in small scale. 

This can be written as an equation:  
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3.7.4 Impeller tip speed (Vtip) constant 

The desire is to have the same the agitation rate of large scale as in small scale. 

This can be written as an equation: 
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บทที ่4 CHAPTER IV 

RESULTS AND DISCUSSION 

4.1 Grid sensitivity analysis 

 Change of grid type and resolution will give effect on the accuracy of numerical results 

and computational time. The reasonable or acceptable grid type and resolution which provide 

consistent simulation results were determined. This thesis employed the technique of adaptive 

mesh in order to refine the mesh as mention previously in Chapter 3 research methodology. 

 

 

 

 In this study, the resolution of structured from coarse grid (adapt I: number of cell = 

86,196), finer grid resolution in adapt II, III and IV (number of cell = 140,628, 368,436, 

1,289,076 and 4,990,452 respectively). This study investigates the effect on power number 
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Figure 4.1 The effect of grid resolution on the simulated power number at speed of 2000 rpm.  
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prediction. The effect of grid resolution on simulation results of power number and the error 

range are presented in Figure 4.1 and Table 4.1 respectively. 

 Figure 4.1 shows that as the mesh was further adapted within the range of 86,196-

368,436 cell, the power number prediction was slightly changed. The error range was 4.04 % -

19.99% as shown in Table 4.1.   

 

Table 4.1 The error range of power number prediction at speed of 2000 rpm  

 

 The error was decreased after increasing the adaption, however longer computational 

time is required. This study employed the adapt II, grid resolution of 368,436 cells due to its 

prediction and computational time was within an acceptable tolerance. Even if increasing the 

further adaption in order to obtain lower error, much longer calculation time is required. Thus the 

Adapt II was then applied to all cases of further studies. 

 

4.2 Preliminary study 

The preliminary study was carried out with two purposes, the first one was to evaluate the 

accuracy of validation experimental method. The experiment was set up to measure power using 

multi-meter. The second one was to compare the influence of viscosity between water and 

carnauba solution on flow behavior.  

4.2.1 Experiment 

   The experiment was carried out to measure power using multi-meter at various speeds. 

The data of current (amperes) were collected while carnauba solution was mixing at various 

2000 rpm Cell %Error Calculation time (hr.) 

Before adapt 86,196 19.99 6 

Adapt I 140,628 17.80 9 

Adapt II 368,436 12.82 13 

Adapt III 1,289,076 8.99 18 

Adapt IV 4,990,452 4.04 24 
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impeller speeds from 2000 to 2900 rpm. The constant potential difference (volts) was also 

measured.   

 

 

 

Speed (rpm) 
Current 

 (I, amperes) 

Power  

(P, watts) 

2000 0.11 24.40 

2100 0.11 24.85 

2200 0.11 25.31 

2300 0.11 26.11 

2400 0.12 26.90 

2500 0.12 27.93 

2600 0.13 29.30 

2700 0.15 33.29 

2800 0.16 37.39 

2900 0.17 39.67 

 

Table 4.2 Current measurement data at potential difference 228 volts for preliminary study. 
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Speed 

 (RPM) 

Power 

(Watt) 

Power number  

(Np) 

Reynolds number 

 (Re) 

2000 24.40 32.17 27,899 

2100 24.85 28.31 29,294 

2200 25.31 25.07 30,689 

2300 26.11 22.64 32,084 

2400 26.90 20.53 33,479 

2500 27.93 18.86 34,874 

2600 29.30 17.59 36,269 

2700 33.29 17.84 37,664 

2800 37.39 17.97 39,059 

2900 39.67 17.16 40,454 

 

Table 4.3 Calculation result of Power number and Reynolds number from the preliminary study. 

 

 As the form of Equation 10, power (watts) can be calculated. The result of power 

calculation was shown in Table 4.2. This table shows that as increasing impeller speed, the 

current and power required for rotating impeller was subsequently increased. 

 From Equation 1 and Equation 4, the Reynolds number (Re) and Power number (Np) can 

be calculated. The result of Power number and (Np) and Reynolds number (Re) was presented in 

Table 4.3. This table illustrates that since the impeller speed was increased, Reynolds number 

(Re) was increased whereas Np was creased. The range of relative standard deviation among the 

replicate experiments was 0%-2.9% which means the repeatability of power measurement is 

satisfied.  

 The data of relationship between NP and Re were then plotted in a log-log plot as shown 

in Figure 4.2.  
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 The power curve in Figure 4.2, Power number (Np) is inversely proportional to Reynolds 

number (Re). It is because solid body rotation depresses the relative velocity between the fluid 

and the impeller blade [50]. As a result, the flow motion of water can be theoretically described 

by laminar flow. 

   

4.2.2 Simulation  

 The simulation was developed based on two models: single phase and multiphase model. 

The different assumption among two models were, the effect of air was neglected for the single 

phase model while was accounted in multiphase model. The governing equation of each phase for  

multiphase model was additionally calculated. 

 

4.2.2.1 Single phase model 

 Viscous model for laminar flow was applied. The modeling was set up to simulate at 

various impeller speeds of 2000 rpm, 2500 rpm and 2900 rpm which correspond to the Reynolds 
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Figure 4.2 Power curve from preliminary study. 
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number of 27,899, 34,874 and 40,454 respectively, in order to calculate torque at each impeller 

speed. The torque is generated by the result of fluid forces impart on impeller surfaces which can 

be divided into two contributions [51]:  

• The pressure contribution is generated by pressure force which applies in a 

perpendicular position to the surface of impeller.  

• The viscous contribution is generated by the shear stresses applied in tangential 

position.  

 The torque also can be calculated from the moment vector on rotating axis (z-axis) by 

summing the product of force vector with the moment arm vector. The FLUENT code provides 

the capability to automatically calculate torque by this calculation. Consequently, the torque value 

is converted into Power number as presented in Equation 3 while Reynolds number can be 

calculated as Equation 4.  
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Figure 4.3 Power curve of single phase simulation from preliminary study. 
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 Then the data of relationship between NP and Re were plotted in a log-log plot as 

depicted in Figure 4.3. Comparison of experiment and single phase simulation can be made as 

shown in Figure 4.3.  

4.2.2.2 Multiphase model 

 

 

 In multiphase system, air was introduced in the top of the tank. The VOF multiphase 

flow model was employed to investigate the accuracy of prediction. VOF model was enabled in 

order to solve the momentum equation for each phase. 

 By the same means of single phase simulation excepting for minor difference in setting 

up step as mentioned in Chapter 4 research methodology, the multiphase simulation can be 

developed as illustrated in Figure 4.4. This figure shows that single phase and multiphase 

simulation for preliminary study give nearly value of Power number in which their error are 

presented in Table 4.3 
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Figure 4.4 Comparison between power curve of single phase and multiphase simulation from preliminary study. 
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Table 4.4 Comparison of percent error between single phase and multiphase simulation 

rpm %Error of  

single phase simulation 

%Error of  

multiphase simulation 

2000 23.51 21.55 

2500 32.72 27.96 

2900 8.56 12.05 

  

 

 The reason of single phase simulation is not far from multiphase simulation, the 

interaction of air may not much affect the mixing system. Thus the simplified single phase model 

based on assumption of air ignored will be reasonable used. 

 Since in mixing process, power consumption is the parameter influenced heat and mass 

transfer process, the accurate estimation of power consumption in mixing tank is crucial factor for 

operation, design and scaling-up the process [52]. As the simulated result of torque prediction 

which can be convert into power consumption, it proves that validated CFD simulation can be 

used as the tool of our studies and can be applied to another similar cases.  

 From these results, we can infer that the preliminary study achieved the first objective. 

The power measurement to obtain power curve (Power number versus Reynolds number) is 

efficiency method to validate the simulation result. Then, preliminary study can be applied to 

carnauba solution study. 

4.3 Carnauba solution study 

The carnauba solution study has been applied from the preliminary study, however a few 

modification of the model is properly made. 

4.3.1 Experiment 

 After carnauba solution was prepared, the power was measured using multi-meter. The 

data of power was collected at speed from 2000 rpm to 2900 rpm and carried out as same 

procedure as preliminary study. 
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Speed (rpm) 
Current 

 (I, amperes) 

Power  

(P, watts) 

2000 0.12 41.42 

2100 0.11 35.16 

2200 0.11 29.22 

2300 0.11 26.52 

2400 0.12 24.18 

2500 0.12 21.94 

2600 0.12 20.16 

2700 0.13 19.03 

2800 0.13 17.46 

2900 0.14 16.18 

 

Table 4.5 Current measurement data at potential difference 228 volts for carnauba solution. 
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Speed 

 (RPM) 

Power 

(Watt) 

Power number  

(Np) 

Reynolds number 

 (Re) 

2000 26.22 39.45               10,438  

2100 25.76 33.48               10,960  

2200 24.62 27.83               11,482  

2300 25.54 25.26               12,004  

2400 26.45 23.03               12,526  

2500 27.13 20.90               13,047  

2600 28.04 19.20               13,569  

2700 29.64 18.12               14,091  

2800 30.32 16.63               14,613  

2900 31.24 15.41               15,135  

 

Table 4.6 Calculation result of Power number and Reynolds number from carnauba solution 

study. 

 

 

 

 The experimental data on the impeller speed and power required, as well as the 

corresponding Reynolds and power number, from the agitation of carnauba solution are shown in 

Table 4.6. Description can be made that when impeller speed is increasing, it produces the 

increasing power consumption of mixing.  

 From  Equation 1 and Equation 4, Reynolds number (Re) and Power number (Np) can be 

calculated. The results are shown in Figure 4.5. The power curve in Figure 4.5 shows that the 

flow motion of carnauba solution can be theoretically characterized that the flow exists in laminar 

region due to the Power decreases with increasing Reynolds number.   
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4.3.2 Simulation 

4.3.2.1 Single phase model 

 Figure 4.6 depicts the validation result of single phase model.  As figure illustrates, 

power number represents the effective transmission of energy to the fluid by the rotational of 

impeller. The relationship was inversely proportional in laminar region. 

 

 

 

 

 

 

 

 

 

 

Figure 4.5 Power curve of carnauba solution study obtained from the experiment. 
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4.3.2.2 Multiphase model 
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Figure 4.6 Power curve of single phase simulation of carnauba solution study. 

 

 

 

 

 

 

 

Figure 4.7 Comparison between power curve of single phase and multiphase simulation from carnauba solution study. 
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 After the failure of chosen VOF model as a result of the residual plot was not converged. 

This may be a result of using the viscosity ratio of fluid is more than 1x103. In this case VOF 

model is found convergence difficulties as proposed by FLUENT [34]. The mixture model is 

successively employed, it solves the mixture momentum equation for mass-averaged mixture 

velocity and solves a volume fraction transport equation for secondary phase. The mixture found 

convergence.  

 Figure 4.7 depicts the deviation of single phase and multiphase simulation from that 

experiment of power number prediction. As illustration, the result of single phase model gives 

obviously satisfaction to the experiment. Multiphase model seem to make large number of error 

from experiment. One cause that the multiphase model given the results in more error was 

simplifying the experimental material (81 % water, 5 % carnauba wax, 9 % ammonia and 5 % 

oleic acid). The most quantity of material using for multiphase model (carnauba wax and water) 

may lead deviated from actual properties of carnauba solution comparing to single phase model.  

Thus more accuracy of single phase has been resorted to the further studies. Single phase 

simulation can give sufficiently valuable information which describes both the qualitative and 

quantitative behavior of mixing. In this present work, single phase simulation result was then 

post-processed in order to study these follows topics. 

4.4 Flow behavior 

 Since flow pattern is very important to determine the mixing performance inside the tank, 

in this section, we study the qualitative analysis of velocity flow field of agitation to examine the 

structure of the flow for laminar mixing. 

 The results of simulation are illustrated by Figure 4.8 a), b) and c).  Figure 4.8 a) presents 

the velocity contour at impeller speed of 2000 rpm.  
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Figure 4.8 Flow patterns at impeller speed of 2000 rpm:  

a) Contours of velocity on the two cross-sectional planes, 

b) Profile of velocity vector through a cross-sectional plane, 

 c) Closed-up profile of the velocity vector around the impeller. 

 

 

Figure 4.8 a) displays that the region around the impeller persist higher velocity than the 

other region which is far away. The flow field in Figure 4.8 b) demonstrates the characteristic 

pattern of the 6-blade impeller, equipped off-center. The velocity of fluid flow discharges axially 

from the blades. The circulation zones are split into two loops i.e. upper and lower of circulation, 

the fluid is mixed axially to the top and bottom of the tank. The first loop of circulation is zone 

near the impeller and the other is above the impeller. As can be seen, the second loop of fluid 

flow of the both sides of the tank seems to be stagnant elsewhere, however the side which the 

impeller is near tank wall exhibits the stronger velocity than the other side. This upper loop may 

become the dead zone which the fluid motion has low velocity, it may cause the velocity to 

transfer fluid is insufficiently for mixing throughout the tank.  

 

 
 

Figure 4.9 Velocity vector represent for overall flow pattern 
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 From the flow pattern in Figure 4.9, its agitating direction determines to be axial mixing. 

Fluid is pushed up and down along the impeller shaft. Such flow pattern would impose essentially 

bulk motion mixing. 

 

 As previously mentioned in Chapter 2 theory section, the continuity and momentum 

equation (Equation 7 and 9 respectively) were applied to solve laminar flow in the mixing tank in 

this study.  The steady state momentum can be arraged as Equation 18 

 

          (11) 

   

            Convection term      Diffusion term 

 

 The momentum is can be transfer through fluid the bulk fluid motion which is 

convective momentum transport (convecion term) and also transfer by viscous action which is 

molecular momentume transport (diffusion term)  [53]. 

  

4.5 Effect of rotational velocity  

Since the flow is in laminar region the nonexistence of turbulent diffusion limit the 

transport across streamlines to relatively slow process of molecular diffusion [53]. In highly 

viscous fluid, the rate of molecular diffusion is extremely slow, convective momentum is the 

important part in this section. 

 Flow pattern of three velocities in Figure 4.10 a, b and c shows that the high velocities 

are produced in the region close to the impeller. The velocity within the region near impeller and 

away from that creates large deviation as displayed in different colors. The region away from the 

impeller motion, decomposed velocities and nearly stagnant fluid are presented at all rotational 

velocities.  

 

( ) [ ] gpVV ρτρ +⋅∇−−∇=⋅∇
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          a)        b)   

Figure 4.10 Contour of velocity magnitude (m/s)  

at speed of a) 2000 rpm, b) 2900 rpm 

 

   a)        b) 

    a) 2000rpm   b) 2900 rpm 

Figure 4.11 Profile of velocity vector  
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 At higher impeller speed, the stronger circulations created.  As can be seen in Figure 4.11 

a) and b), the higher order of magnitude of velocity vector appear in higher impeller speed. The 

simulated model predicts weak circulations pattern presented by low velocity region which could 

not affects every part of tank and there may cause insufficient mixing performance.  

 Increasing rotational velocity affects the flow hydrodynamics and mixing. The higher 

rotational velocity leads the higher fluid transfer by bulk fluid motion which helps increasing 

better mixing performance. 

 

4.6 Effect of viscosity 

The pattern of fluid flows in mixing tank depends on many factors, e.g. type of impeller, 

and the characteristic of fluid, especially its viscosity. This section investigates the influence of 

kinetic viscosity which is a parameter in the term of diffusion term.   

 In this study, the flow pattern of two fluid i.e. water and carnauba solution possess 

different Reynolds due to different viscosity is illustrated.  

 Figure 4.11 a) and b) shows the flow behavior of water and carnauba solution 

respectively. The considerably difference of flow behavior between two fluids is within the region 

far away from impeller. As this figure exhibits, in water mixing the velocity contributes 

throughout the tank better than carnauba mixing. The low velocity (blue shade) in carnauba 

solution is more apparent and may contribute to poor mixing performance. 
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Figure 4.12  Magnitude velocity contours (m/s) at 2000 rpm. 

 
 

a)       b) 

          a) cross section plane of water  b) cross section plane of carnauba solution.  

 

4.7 Effect of shear stress 

Mixing two immiscible liquids produce the production of a disperse phase distributed in 

other phase as the form of small droplets [54].  Drop size distribution in an agitated dispersion is a 

result of the dynamic equilibrium which consists of the breaking and coalescing drops, increasing 

the drop breakage rate or decreasing the drop coalescence rate produces smaller drop sizes. In 

dynamic flow system, the maximum drop size can be determined by the external deformation 

forces and restoration forces: 

• The external deformation force is the result of turbulent fluctuation and viscous 

stress due to velocity gradients of surrounding field. 

• The restoring force is the result of the interfacial tension and/or the internal 

viscous stress.  
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 Regarding to Newton’s law of viscosity, viscous (shear) stress (τ ) this “Momentum 

flux” example in x-y direction can be expressed as follows: 

 

    

y

x

xy dv
dvµτ −=         (12) 

 

 The Newton’s law of viscosity equation or molecular transport of momentum, represents 

the relation between shear force per unit area and the negative velocity gradients. It describes 

transfer of momentum component in each direction (for example in equation 5, the x-momentum 

transmits in y-direction) with velocity gradient as the driving force.  The fluid transport happens 

by intermolecular forces among their surround. Consequently, when shear stress increases the 

force in which dissipates to breakage of molecules is also higher. The result of shear stress at the 

impeller speed of 2000 rpm and 2900 rpm shows in Figure 4.13 which is observation in the z-axis 

between the impeller and tank wall (red line) presented in Figure 4.12. The shear rate is decreased 

toward from the impeller blades because of moderated velocity. The shear stress found maximum 

at the tank wall as a result of wall shear stress. This result agrees with Deplano et.al. [55] 

investigated the wall shear stress analysis. 

 The higher impeller speed of 2900 rpm generates higher magnitude of shear rate than 

2000 rpm. This simulated result may indicate that the higher the mixing performance due to the 

higher external deforming force (only viscous stress because turbulent fluctuation is absence in 

our study), the larger the speed of impeller. 
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Figure 4.13 Position of shear stress considerations. 

  Figure 4.14 Shear stress of 6-blade impeller as a function of position. 

 

4.8 Effect of scale-up criteria 

 

 Once the flow regime and its influence have been studied, the validated model of single 

phase simulation is then employed to large-scale tank. As previously mentioned in Chapter 2, the 

scale up criteria based on similarities can be expressed in term of the geometrical similarity, 
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kinematic similarity and dynamic similarity. In this research followed the geometric similarity 

and kinematic principle. Geometric similarity is really not needed but serves as a starting point for 

scale up [56]. The same configuration of the lab-scale and large-scale tank was conducted so that 

the fluid motion of the small and large sizes was assumed to be similar. A result, geometric 

similarity provides kinematics similarity [57]. The kinematic similarity refers to the motion and 

the same ratio of velocities for the corresponding positions in the mixing tank.  

 The different scale-up criteria i.e. Reynolds number (Re) constant, Froude number (Fr) 

constant and Impeller tip speed (Vimp) constant are summarized.  Results of normalized velocity 

with normalized position of each scale-up criteria represented kinematic comparison. The 

simulated result of velocity profile in Figure 4.15 shows the normalized velocity derived from 

various scale-up criteria. The scale up criteria of Fr constant, Re constant and Vtip constant is still 

not accomplished. 
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บทที ่5 CHAPTER V 

CONCLUSIONS AND RECOMMENDATIONS 

 

Conclusions 

 In this thesis, Computational Fluid Dynamics simulations have been developed to study 

the transport phenomena inside the mixing tank of carnauba solution. The flow regime of 6-blade 

impeller which equipped off-center has been investigated. Then, the scale-up criteria is 

summarized.  The conclusions relating to research objectives are followings: 

1.2.1 To develop a suitable CFD model to study fluid dynamic of carnauba solution 

  inside the mixing tank. 

• CFD modeling was successfully developed and applied to study the 

flow behavior inside the mixing tank based on assumption of laminar 

and steady state flow. 

1.2.2 To study the phenomena of fluid mixing using the validated CFD model. 

• 6-blade impeller equipped off-center used in carnauba solution mixing 

the tank was introduced and the resulting flow pattern was investigated 

using CFD simulation.  

• Increasing rotational velocity, the mixing performance was increased.  

• Decreasing viscosity, the mixing performance was increased.  

• Increasing shear stress (increasing rotational velocity), the particle size 

would be decreased. 

1.2.3 To summarize and guide the scale-up criteria for carnauba solution tank. 

• The scale-up criteria of Fr constant, Re constant, Vtip constant are not 

accomplished the kinematic similarity. 

 

 

 

  

 

CHAPTER V 
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Recommendations 

  

• This study gives better understanding of the flows within the mixing tank with 6-blade 

impeller which mounted off-center.  However it should be noted that this study is subject 

to modeling assumption of laminar and steady state flow. There are still rooms for 

improvement the model to be more realistic. Lessen assumptions should be required. 

• Optimum condition in lab-scale tank should be ensured before applying to CFD 

modeling. 

• Other criteria could be further considered such as Webber number constant and Power 

energy constant which based on the emulsion size of the emulsion was the same [58]. 

Moreover, more than one criterion should be kept constant such as Reynolds number and 

Froude number (Fr). 
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APPENDIX A 

ANSYS FLUENT SOLUTION METHOD OF PRELIMINARY STUDY 

   

 Variables input for FLUENT Single phase (pure water) 

 

Step 1: Problem setup 

 

1. The FLUENT program was opened in three dimensions according to the geometry and 

mesh generation. Parallel option was selected where number of processes were depended 

on the number of CPU possess by individual computer.  

Click OK. 

 

 f  

 

2. The exported mesh file from GAMBIT was imported into FLUENT program.  

File > Read > Mesh 
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3. Check the mesh. 

Mesh > Check 

4. When lunch to FLUENT software, general information was input, pressure-based, steady 

state with absolute velocity formulation and gravity of 9.81 m/s2 in negative z direction 

(the direction of impeller shaft rotated inversely with the gravitational acceleration). 

    

 
 

 

5. Chang the unit of angular velocity as rpm and length as mm 



68 

Units > Quantities 

 

  
 

6. Check the domain whether it corresponded to actual physical dimension. Scale the mesh 

in millimeter unit. 

 

 
 

 

7. Next step, the viscous model was selected. Due to the mixing is in laminar flow, model 

panel was kept default. 
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8. In material panel, added liquid water to the list of material. Click change/create to replace 

the existing data of air. 

Materials > Create/Edit > Fluent Fluid Material > Water liquid > Change/Create 

 > Close 

 

 

 
 

 

 

9. Define moving zone in cell zone condition window click Edit, frame motion and 

rotational velocity of 2000 rpm were selected. 
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Cell Zone Conditions > moving > Edit > OK 

  
 

 

10. Kept default in stationary zone. 

 

 
 

11. Define boundary conditions in boundary condition window click Edit. 
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• For impeller boundary condition, the wall motion was as stationary wall and shear 

condition was set as no slip. 

 

     
 

 

• For shaft boundary condition, the wall motion was as moving wall. Motion was set as 

absolute with rotational speed of 2000 rpm. Shear condition was set as no slip. 

 

        
 

• For tank boundary condition, the wall motion was as stationary wall and shear condition 

was set as no slip. 
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• For top boundary condition, the wall motion was as stationary wall and shear condition 

was set as no slip. 

 

    
 

• The operating condition, operating pressure was set at 1 atm and gravity was kept default 

(as it was already set in scale setting step). The reference Pressure location was set at 138 mm 

in z position due to pressure acted on this location.  
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Define > Operating Conditions > OK 

 

 

 
 

12. In reference values window, compute from panel was drop down and selected impeller. 

Area and length is impeller dimension. Density and viscosity are possessed by water.  

 Reference zone was drop down and selected moving. 

 

 
 

Step 2: Solution  

1. In solution methods panel, the discretizations were defined as follows  
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Solve > Controls > Solution 

Pressure-velocity coupling: Coupled 

Gradient: Least Square Cell Based 

Pressure: PRESTO 

Momentum: First Order upwind 

Pseudo Transient was enabled as recommended by FLUENT as it helped decrease 

number of iterations for convergence. 

 

 
 

2. Retain the default Control solution.  

3.  
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4. Initial the flow on Solution initialization. Select standard initialization and absolute 

reference frame. 

Solution initialization > Initial 

 

 
 

5. Create two new surfaces monitor. One monitor was to observed pressure along the 

impeller and the other one was to investigate velocity. 

Create pressure monitor 

• Surface Monitors > Create > Surface > impeller >Name impeller > OK 
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Create velocity monitor 

• Surface Monitors > Create > New Surface > Iso-Surface > Surface of Constant > 

 z-coordinate > Iso-Values > New surface name  z = -8 

 

   
 

6. Then, save case and data file. 

File > Write > Case (2000rpm_water) 

7. Start the calculation by iterating the solution until the solution converges at 10-3 residue. 

Run Calculation > Calculate 

 

 
 

8. After the solution are converged at 10-3residuals, save case and data files 

(2000rpm_water.gz) 

9. On the monitor panel, deselect convergence of residual plot for all equations. 

Click Plot >OK > Close 
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10. Continue the calculation by iterating the solution until the monitors reached a constant 

value. 

Run Calculation > Calculate 

11. Save case and data files (2000rpm_water.gz).  

 

Step 3 Post-processing 

1. This step torque calculation can be reported.  

Reports > Force > Force Report  
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2. In force reports panel, moments option was selected. Define the moment z-axis as -1 

accordingly to vector moment direction. The summation of torque calculation acting on 

impeller was reported. 

 Moments > add value -1 in Moment Axis > Print 
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Variables input for FLUENT Multiphase (water-air) 

 

 Since the multiphase flow model of water-air was developed, the major specifications 

were similar to single phase. Minor differences were described in this section. 

 

Step 1: Problem setup 

1. The general settings were carried till the step of the viscous model. The multiphase 

model was added. Volume of Fluid (VOF) was selected. Number of Eulerian phase was 

kept constant at 2. Implicit scheme was selected. Retain the default settings 

 

Models > Multiphase > Volume of Fluid 

 

 
 

2. Add water to the list of fluid material by keeping the existing data of air so that in 

material list consisted of water and air. 
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Materials > Create/Edit > Fluent Fluid Material > Water liquid > Change/Create 

 > Close 

3. The next step, specify the phases. Define water as primary phase where air was 

secondary phase. 

Phases > Primary phase > Edit > Phase Material > Select Water 
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  Secondary phase > Edit >Phase Material > Select Air 

 

4. Define cell zone condition and boundary condition as the same procedure as single 

phase. 

 

Step 2: Solution  

1. In solution methods panel, the discretizations were defined as follows  

Solve > Controls > Solution 
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2. Retain the default Control solution.  

Pressure-velocity coupling: Coupled 

Gradient: Least Square Cell Based 

Pressure: PRESTO 

Momentum: First Order upwind 

Volume fraction: Modified HRIC 

Pseudo Transient was enabled as recommended by FLUENT as it helped decrease 

number of iterations for convergence.  

 

 
 

3. Initial the flow on Solution initialization. Select standard initialization and absolute 

reference frame. 

Solution initialization > Initial 
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4. On the monitor panel, the same new surface monitors as single phase are created. 

5. Define the starting height of the liquid inside the tank. On region adaption panel, 

the input coordinate in x, y, z positions are defined as follow.  

 

 
 

Adapt > Region > Region Adaption 

Click > Mark 

6. Then, save case and data file. 

File > Write > Case (2000rpm_water_air) 

7. Start the calculation by iterating the solution until the solution converges at 10-3 residue. 

Run Calculation > Calculate 
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8. After the solution are converged at 10-3residuals, save case and data files 

(2000rpm_water.gz). 

12. On the monitor panel, deselect convergence of residual plot for all equations. 

Click Plot >OK > Close 

 

 
 

13. Continue the calculation by iterating the solution until the monitors reached a constant 

value. 

Run Calculation > Calculate 

14. Save case and data files (2000rpm_water_air.gz).  

 

Step 3 Post-processing 

The torque calculation step can be followed the single phase reporting. 
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APPENDIX B 

STATISTIC CALCULATION 

  Deviation 

 

Speed (rpm) 2000 2100 2200 2300 2400 2500 2600 2700 2800 2900 

Experiment I 24.396 24.852 25.308 26.106 26.904 27.930 29.298 33.288 37.392 39.672 

Experiment II 23.422 23.991 24.559 25.241 26.151 27.174 29.298 33.288 35.929 38.772 

x  23.91 24.42 24.93 25.67 26.53 27.55 29.30 33.29 36.66 39.22 

s 0.69 0.61 0.53 0.61 0.53 0.53 0.00 0.00 1.03 0.64 

RSD 2.9 2.5 2.1 2.4 2.0 1.9 0.0 0.0 2.8 1.6 

 

Average ( x )      
n

xxxxx ...
4321
++++

=  

 

 

Standard Deviation (s)   
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2

2

2
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Relative Standard Deviation (RSD)  100)( ×= xsRSD  

 

 Percent error 

Error = ( Expt Value – Predicted Value)   X 100 

    Expt Value 

 

 

 

 



86 

BIOGRAPHY 

 Miss Nantikan Lamaipan was born in September 25 th, 1987 in Bangkok, 

Thailand. She graduated in Bachelor’s degree from the department of Chemical Technology,  

Chulalongkorn University in May 2010. Then, she has studied further in the Master’s Degree 

from department of Chemical Engineering, Chulalongkorn University and has joined the 

Biochemical Engineering Research Laboratory since in 2010. 

 In April 2013, she participated in PPC Symposium on Petroleum, Petrochemical and 

Polymers Conference (PEREOMAT and PPC SYM 2013), Bangkok, Thailand for proceeding 

published in “Computational Fluid Dynamics modeling of a mixing tank for the production of 

shellac-carnauba wax fruit coating solution”. 

 

 

 

 


	Cover (Thai)
	Cover (English)
	Accepted
	Abstract (Thai)
	Abstract (English)
	Contents
	Chapter I Introduction
	1.1 Motivation
	1.2 Objective of the Research
	1.3 Scope of the Research
	1.4 Benefits of the Research

	Chapter II Thoery and Literature Reviews
	2.1 Fruit Coating Production Process Development of Shellac- Carnauba Wax Based
	2.2 Fluid Mixing
	2.3 Scale-Up and Scale-Down of Liquid Mixing System
	2.4 Cfd Model of Mixing Process
	2.5 Computational Fluid Dynamics (CFD) Model of Shellac-Carnauba Wax Fruit Coating Solution.
	2.6 Computational Fluid Dynamics
	2.7 Governing Equations of Fluid Dynamic

	Chapter III Research Methodology
	3.1 Objective and Approach
	3.2 Preliminary Study
	3.3 Carnuaba Solution Study
	3.4 Grid Sensitivity Analysis
	3.5 Validation Approach
	3.6 the Effect on Flow Behavior
	3.7 Scale Up Study

	Chapter IV Results and Discussion
	4.1 Grid Sensitivity Analysis
	4.2 Preliminary Study
	4.3 Carnauba Solution Study
	4.4 Flow Behavior
	4.5 Effect of Rotational Velocity
	4.6 Effect of Viscosity
	4.7 Effect of Shear Stress
	4.8 Effect of Scale-Up Criteria

	Chapter V Conclusions and Recommendations
	References
	Appendix
	Vita



